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1 Graphical user interface 

The graphical user interface of the Atlas Viewer consists of three components: The Main 

menu at the top, the Map display on the right and the Legend/Info of the map on the left 

(see Figure 1). 

1.1 Main menu and its structure 

The Main menu is structured into the following parts (Figure 2): 

1. File (see section 1.2) 

2. Maps (see section 2) 

2.1. The Project 

2.2. Climate 

2.3. Hydrology 

2.4. Water Management  

2.5. Agriculture 

2.6. Ecosystems 

2.7. Socio Economy 

2.8. Land Use 

3. Background (see section 1.3) 

4. Help (see section 1.4) 

 

Figure 2 The Main menu of the GLOWA JR Atlas. 

1.2 The menu File -  

If you click on the file menu a window opens with the options showed in Figure 3. 

 

Figure 3 The options of the file menu. 
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1.2.1 Save screenshot: Creating a map 

The main function of the File menu is to quickly produce a map out of the currently visi-

ble map extent. It can be done via Save screenshot or pressing the Print Screen button on 

your keyboard. The following dialogue lets you choose one of the following (Figure 4): 

 Overall view: Consists of the map and the legend/info tab on the left side.  

 Map extract with coordinates: Consists of the map with the corresponding grid 

values at the map frame.  

 Only the map extract. 

After entering a destination and a name for the file the map is stored as an image file.  

 

Figure 4 The Save screenshot window. 

1.2.2 Download whole atlas (disabled) 

This option is disabled since the GLOWA JR Atlas will not be available through the web start. 

If an atlas is accessed with the web start  , you can select Download whole atlas 

in order to store it on your personal hard drive. Once downloaded no further online access is 

needed to view the maps.  

1.2.3 Change language (disabled) 

This option is disabled since the atlas is at the moment just available in English. 

1.2.4 Open popup-window 

By selecting submenu Open popup-window you can take a look at the first window that 

opens when opening the atlas (Figure 5). 
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Figure 5 The GLOWA Jordan River Atlas popup-window. 

 

1.2.5 Terms of use window 

By selecting this button you open the Terms of use. Please accept them if you use data of the 

atlas (Figure 6).  

 

Figure 6 The Terms of use of the GLOWA Jordan River Atlas. 

 

1.2.6 Exit 

By selecting submenu Exit the user can end the Atlas Viewer. Attention: All changes made by 

the user will not be saved! After rebooting, the original settings will be used. 

1.3 The menu Background -  

The menu Background allows the user to add further layers with background information 

into the current map view (see Figure 7). These layers have predefined styles so that the 
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user can directly create a map. See section 3.5.1 on how to change the look of these layers 

and on how to label them. 

 
 

Figure 7 The layers below the menu Background. 

 

Please note: Because of the large amount of data within the background layers, it depends 

on the scale of your map, how much is visible in the current extent. This means, that more 

units may occur if you zoom in. To get quick information on the units, please use the Info 

symbol   (see section 3.3.1). 

1.4 The menu Help -  

The menu Help provides this user´s manual. Apart, the user can activate or deactivate the 

setting Draw “softer” maps (see Figure 8).  

 

Figure 8 The menu Help 

It is preferable to deactivate the setting Draw “softer” maps in order to be able to identify the 

modelling grids, e.g. in the maps under the menu Climate. By activating Draw “softer” maps, 

the maps will be processed with anti-aliasing algorithm which apart causes a slower display 

of the maps (see Figure 9).  
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Figure 9 The map on the left with deactivated setting Draw “softer” maps; map on the right with activated 
setting Draw “softer” maps of the menu Help. 

 

The submenu About GLOWA Jordan River Atlas summarizes the aim of the atlas as well as 

further information and contact details (Figure 10). 

 

Figure 10 The submenu About GLOWA Jordan River Atlas. 

The submenu Logging considers the creation of a log file atlas.log where errors, warnings 

and other information are stored in a file.  

2 Map display 

Within the map display (Figure 11) the tools described in Table 1 can be used in order to 

look at the data. 
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Table 1 The tools of the map display. 

 
Pan Moves the map according to mouse movement 

 
Info Returns the selected raster cell’s or shape’s attributes  

 
Zoom in Magnifies the selected area 

 
Zoom out Demagnifies the selected area 

 
Last view Switches back to the previously viewed area 

 
Next view Switches forward to the previously viewed area 

 
Default view Shows the default view of the map 

 
Search  Searches for layer names, datasets and attributes* 

* Note, that the Search tool only finds names of labeled objects in the map. A description on 

how to label objects is given in section 3.2.1.  

If you want to search within whole datasets, open the corresponding attribute table (3.3.2) 

or use a filter (3.5.3).  

 

Figure 11 Example of the map display. 
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3 Layer information 

3.1 The Info tab -  

When opening a map the Info tab automatically opens (see Figure 12). It describes the map 

with it´s respective layers. It provides a key message, as well as indications about where to 

find information on the source of the map layers, on how to cite the layers, information 

about the contact persons as well as about the data availability. It also provides links to fur-

ther information.  

 

Figure 12 The Info tab 

3.2 The Legend tab -  and layer functions -  

The legend manages order and visualization of each map layer within the current map dis-

play (Figure 13). The illustration of the layers is the same as within the legend (from top to 

bottom). The order of a map layer can be modified with the mouse by 'Drag and Drop'. 

 

Figure 13 Example of a legend. 
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In Table 2 the available layer functions at the taskbar of each layer are listed. Figure 14 

shows the specific tool functions. 

Table 2 The layer functions. 

 Metadata 
Shows information about the layer’s source, owner and citation 
methodology, author, time of creation 

 Visibility When open, layer is visible. Change by clicking 

 Tools Enables different layer options, see section 3.2.1 (Figure 14) 

 Extend Shows and hides the layer legend 

 

 

Figure 14 The specific tool functions: filter, remove filter, style, attribute table and remove layer. For some 
layers the export of the data set is also given. 

3.2.1 Layer tools function -  

Table 3 The layer tools function. 

 Filter Helps displaying only desired information, see section 3.5.3 

 Remove Filter 
Shows all of the available layer information 

only available if a filter has been applied 

 Style Opens a new menu to change the style (e.g. colour) of the layer. 

 Attribute Table Shows all of the layer’s attribute information, see section 3.3.2 

 Remove Removes the layer from the current map 

 Export 
Stores the selected dataset on the local hard drive  

only available if allowed by the author of the data 

 

3.2.2 Layer views 

Many layers contain more information than visible at first sight. In most of the cases there 

are temporal differences, varying methods or comparable scenarios. These sets of infor-
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mation are called “views”. If there are more than two selectable views a drop down menu 

helps changing each layer’s view. For example in Figure 15 four views can be viewed. 

 

Figure 15 Drop down menu displaying the different styles of one layer. 

Each raster cell or vector feature contains different information in the corresponding views. 

They can be viewed by clicking the info symbol .  

3.3 Layer values 

3.3.1 Info symbol -  

By clicking on the info button  in the toolbar (see section 2) the mouse cursor changes 

into a cross ⊹ with an i. By clicking on a raster cell or vector feature a new window opens 

which contains information about the selected location or area (Figure 16). This set of in-

formation is stored in the attribute table (see section 3.3.2) and can differ between the da-

tasets. If a raster dataset has more views (see section 3.2.2), all of them are showed in this 

window.  
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Figure 16 Example of a window containing information about the selected raster cell after clicking on it with 
the info button. 

3.3.2 Attribute table -  

Vector features (points, lines, polygons) store additional information (numbers or text) in an 

additional table which is internally linked to the geometrical data (Figure 17). This allows 

the user to work with the data according to their type of information. The attributes can be 

viewed by using the attribute table function  within the tools function  of the taskbar of 

the layer (Figure 14). Note that raster files do not have attribute tables, they only have cells 

containing the corresponding numbers. 
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Figure 17 Example of an attribute table with selected attributes. 

3.4 Layer metadata-  

The user obtains metadata about the map layer by selecting Info  at the taskbar of a layer 

(see 3.2). The metadata contains details about the data set title, the authors, the year of pro-

duction, the source, the way of citing the data, the contact persons, the availability of the 

data and the methodology of creating the data.  

3.5 Layer Options 

3.5.1 Change style -  and label datasets 

By selecting the style button  of the tools function  of the taskbar of the layer a window 

opens (see Figure 18).  

 

Figure 18 The style window, that allows the atlas user to change the style of the layers. The window above is 
for polygon layers the below for raster layers. 

 

This option is very powerful when it comes to mapping. The user can not only change the 

colors of the displayed data (manually or by predefined color scales), it is also possible to 
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change the classification thresholds which divide the data in various classes. By clicking 

Classify the breaks dividing the available range of displayed data can be changed.  

Here is a description on how to label vector datasets within the style window, which is espe-

cially useful for points, lines and polygons. After selecting Style  click Add new (left hand 

side)  choose Labels and confirm. Select the attribute which's field shall label the ob-

jects . Confirm by clicking . See Figure 

19. 

 

Figure 19 Label datasets within the style window. 

 

3.5.2 Selection tools -  and  

When opening the attribute table of vector features (see section 3.3.2) the four tools de-

scribed in Table 4 are added to the map display. The attribute table has the four tools de-

scribed in   
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Table 5 (see also Figure 17, Figure 20).  

Table 4 Selection tools of the map display when opening an attribute table. 

 Select  
Selects features by dragging a rectangle and marks them either at the 
map display as well as at the attribute table 

 Add  
Adds features to the current selection by dragging a rectangle and marks 
them either at the map display as well as at the attribute table 

 Remove  
Removes selected features from the current selection either at the map 
display by dragging a rectangle as well as at the attribute table 

 Clear  
Clears all selections either at the map display as well as at the attribute 
table 
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Table 5 Selection tools of the attribute table 

 Clear  
Clears all selections either at the map display as well as at the 
attribute table 

 Move to the top Moves selected features to the top of the attribute table 

 Invert selection 
Deselects the selected features and selects those features that 
were not selected 

 Zoom to selection Zooms within the map display to the selected features 

 

 

Figure 20 Ways of displaying selected items: On the left side of the attribute table in red. The corresponding 
part in the map is hatched with red lines.  

 

3.5.3 Filter -  

The filter  allows reducing the displayed map content according to defined rules. The 

filter is individually defined and applied in the filter window (Figure 21). After the use of a 

filter, only the filtered objects will be visualised. 
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Figure 21 The filter window 

 

In the attribute table all possible variables of the layer on which a filter can be based are 

displayed (including property). The filter can be defined below Rule (see Figure 21): through 

a double click on a variable, it is taken in the formula field. Now the user chooses the wished 

operator from the list of Operators. It is up to the user to define its own operator or one of 

the list. Finally, a value or a range of values must be defined. The value can be a name (file 

type: string) or a number (file types: Integer, double, long). If the filter is based on names, it 

must be put in inverted comma (‘…’).  

After defining a filter, the user can check the validity of the rule. If the filter is correct, the 

preview image as well as the table will change. If there is any error in the filter, an error 

message will appear and the preview image will disappear (and also the table in the current 

version). Thus, the rule must be adjusted. If the filter is correct, it can be applied by clicking 

on Apply (see Figure 22). 
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Figure 22 Map before and after using the filter tool (see Figure 21). 

 

3.5.4 Export -  

Some of the datasets can be downloaded for the use in Geographic Information Systems 

(GIS). Vector data is provided in the ESRI Shapefile format, raster data in TIF format.  

If a dataset is downloadable depends on the authorization of the owner. Data can be down-

loaded if the entry Export  is available in the tools function  (see Figure 14). After 

accepting the terms and conditions a folder on your local hard drive can be selected where 

the geodata is stored.  

Important: It depends on the author of the data in which coordinate system the data is pro-

jected and which preferences (attribute names, NoData value etc.) are chosen for each da-

taset. Therefore, these settings can differ between the various datasets. It is assumed that 

you have basic knowledge in GIS when downloading and using the data. Otherwise we sug-

gest modifying the data according to your needs directly in the atlas application for the crea-

tion of maps.  

 

 

 

 

 

F_Yield > 4000 
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4 Troubleshooting / FAQs 

In the following, we provide answers to the most upcoming questions during our test phase. 

We hope you will find the right solution in one of the following topics.  

4.1 The atlas does not work. What can I do? .......................................................................................16 

4.1.1 Make sure Java is installed on your computer ..............................................................16 

4.1.2 Delete your Java cache............................................................................................................17 

4.1.3 Delete your Java Web Browser Cache ..............................................................................17 

4.1.4 Activate Java plugins in your browser .............................................................................18 

4.1.5 Allow the Geopublisher application in your Windows firewall .............................19 

4.2 Are there any other languages besides English supported? ..................................................20 

4.3 The raster files in my atlas are blurred ..........................................................................................20 

4.4 I can't zoom to a certain region .........................................................................................................20 

4.5 I have downloaded some geodata: How can I open them? .....................................................21 

4.6 I exported some raster data from the atlas. What do they display? ...................................21 

4.7 How was the map/dataset created? What are the sources? ..................................................21 

4.8 I want to refer on the results displayed in the atlas. How shall I cite? ..............................21 

4.9 I have questions on the data. How can I contact responsible persons? ............................22 

 

4.1 The atlas does not work. What can I do? 

4.1.1 Make sure Java is installed on your computer 

Although the atlas is supposed to automatically check if your computer has the Java envi-

ronment and downloads it in case it is not there, errors can occur according to your personal 

configuration. 

If you want to check if you have Java, please visit the following page. 

https://www.java.com/en/download/installed.jsp  

and klick "Agree and Continue".  

 

If you don't have the latest version of Java you will be redirected to the installation page. 

Please go through these instructions to install Java. 

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941
https://www.java.com/en/download/installed.jsp


Braun A & Claus C (2014) The GLOWA Jordan River Atlas Manual. In: Claus C, Braun A, Schloz D, Tielbörger K 
(ed.) (2014) GLOWA JR Atlas: Results of the GLOWA Jordan River Project. http://nbn-
resolving.de/urn:nbn:de:bsz:21-dspace-579413, http://hdl.handle.net/10900/57941. 
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If you want to install Java without checking, please visit the following page and select the 

package according to your operating system: 

http://java.com/en/download/manual.jsp 

4.1.2 Delete your Java cache 

This removes temporary files of your Java Environment and solves most of the problems 

based on newly used Java applications. However, the solution depends on your operating 

system.  

Windows: 

a) Click Start > Control Panel. 

b) Locate and double click the Java icon in the Control Panel. 

c) Click Settings under Temporary Internet Files. 

d) Click Delete Files. 

e) Select all boxes and click OK on Delete Temporary Files window. 

f) Click OK on Temporary Files Settings window. 

g) Click OK to close the Java Control Panel. 

Mac OS X 

a) Double click your Mac hard drive. 

b) Double click Applications. 

c) Double click Utilities. 

d) Double click Java Preferences. 

e) Click the Network tab. 

f) Click the Delete Files... button. 

g) You are prompted to delete your temporary files for Java. Make sure all boxes are se-

lected with check marks. Click OK. 

h) Close the Java Preferences window. 

 

4.1.3 Delete your Java Web Browser Cache 

Depending on your web browser try one of the following instructions.  

Firefox 

a) Click Tools from the Firefox menubar. 

b) Click Options. 

c) Under the Advanced options, click the Network tab. 

d) Clear cache under Cached Web Content. 

 

 

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941
http://java.com/en/download/manual.jsp


Braun A & Claus C (2014) The GLOWA Jordan River Atlas Manual. In: Claus C, Braun A, Schloz D, Tielbörger K 
(ed.) (2014) GLOWA JR Atlas: Results of the GLOWA Jordan River Project. http://nbn-
resolving.de/urn:nbn:de:bsz:21-dspace-579413, http://hdl.handle.net/10900/57941. 
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Internet Explorer 

Deleting web cache in Internet Explorer (IE) varies based on your IE and Windows version. 

The options to remove cached web pages are found under Tools (Internet Options or Safety) 

then Browsing History in IE. 

Chrome 

a) Click the Customize icon on browser tool bar. 

b) Select Settings, then Show advanced settings. 

c) Under Privacy, select Clear browsing data. 

d) In the dialog that appears, select the checkboxes for the types of information that you 

want to remove. Use the menu at the top to select the amount of data that you want 

to delete. Select beginning of time to delete everything. 

e) Click Clear browsing data. 

 

4.1.4 Activate Java plugins in your browser 

Internet Explorer 

Click Tools and then Internet Options 

a) Select the Security tab, and select the Custom Level button. 

b) Scroll down to Scripting of Java applets. 

c) Make sure the Enable radio button is checked. 

d) Click OK to save your preference. 

 

Chrome 

a) Enter about:plugins in the search field. 

b) In the Plug-ins list, look for Java and check whether Java is enabled (if the Disable 

link appears, Java is already enabled). 

c) Click on the Enable link (if available). 

d) (Optional) Check the Always allowed box to stop additional Chrome warnings when 

running Java content. 

Firefox 

a) Open the Firefox browser or restart it, if it is already running. 

b) From the Firefox menu, select Tools, then click the Add-ons option. 

c) In the Add-ons Manager window, select Plugins. 

d) Click Java (TM) Platform plugin (Windows) or Java Applet Plug-in (Mac OS X) to se-

lect it. 

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941


Braun A & Claus C (2014) The GLOWA Jordan River Atlas Manual. In: Claus C, Braun A, Schloz D, Tielbörger K 
(ed.) (2014) GLOWA JR Atlas: Results of the GLOWA Jordan River Project. http://nbn-
resolving.de/urn:nbn:de:bsz:21-dspace-579413, http://hdl.handle.net/10900/57941. 
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e) Check that the option selected is Ask to Activate or Always Activate or on older Fire-

fox versions, click on the Enable button (if the button says Disable, Java is already 

enabled) 

Safari 

a) Click on Safari and select Preferences. 

b) Choose the Security option. 

c) Select Allow Plug-ins, then click on Manage Website Settings. 

d) Click on the Java item, select an option (Ask, Allow or Allow Always) from the pull-

down list When visiting other websites. 

e) Click Done, then close the Safari Preferences window. 

Opera 4.x and Up 

1. Opera for Windows does not use Java, but an embedded version already inside the 
Opera Web browser.  

2. Opera for other platforms may supports Java. Please consult your Opera platform 
documentation.  

3. For further information, please review the following Opera Support article:  
Support for Java software in Opera  

4.1.5 Allow the Geopublisher application in your Windows firewall 

On Windows you need to allow your Geopublisher application to pass the installed Windows 

firewall. When starting the atlas a window like shown below can occur.  

 

 

Make sure you click "Allow access" allow Java to use your network connection. 

 

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941
http://www.opera.com/support/search/supsearch.dml?index=375&session=55ac7764ed241a35001511478a6f1c19


Braun A & Claus C (2014) The GLOWA Jordan River Atlas Manual. In: Claus C, Braun A, Schloz D, Tielbörger K 
(ed.) (2014) GLOWA JR Atlas: Results of the GLOWA Jordan River Project. http://nbn-
resolving.de/urn:nbn:de:bsz:21-dspace-579413, http://hdl.handle.net/10900/57941. 
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4.2 Are there any other languages besides English supported? 

The GLOWA Jordan River Atlas is a part of the international research project. You can 

change the language under Options > Change Geopublisher language. As the languages of the 

user interface are provided by the development team, no further languages are supported.  

  

4.3 The raster files in my atlas are blurred 

If some of the datasets have fuzzy edges like in the image below, the so called Anti-Aliasing 

function is active. This means that, instead of displaying hard barriers, your graphic board 

tries to smoothen the value patterns of a raster dataset in order to produce more continuous 

colors. However, especially with rasters of coarse resolution (such as climate models), this 

effect is not wanted. You can switch between the two modes under Help > Draw softer maps. 

 

 

 

4.4 I can't zoom to a certain region  

Every layer in the atlas has a specific frame, within it is valid. Therefore, maximum extents 

have been defined for every. There is no valid data outside these extents. If you want to nav-

igate to the edge of a dataset it is more helpful to use the pan-tool:   

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941


Braun A & Claus C (2014) The GLOWA Jordan River Atlas Manual. In: Claus C, Braun A, Schloz D, Tielbörger K 
(ed.) (2014) GLOWA JR Atlas: Results of the GLOWA Jordan River Project. http://nbn-
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4.5 I have downloaded some geodata: How can I open them? 

We expect the user of the export function to have a basic knowledge of GIS 

data. As a free and open source GIS software QGIS is suggested if you want to 

open and work with the data. It can be found at http://www.qgis.org.  

  

4.6 I exported some raster data from the atlas. What do they display? 

Most of the raster data in the atlas contain various styles (see section 3.2.1). This means they 

contain more than just one layer of information. This is called a layer stack and can be un-

derstood as a pile of maps covering the same extent and spatial resolution. In case of this 

atlas layer stacks can be exported in TIF format. The amount of layers and their order corre-

sponds to their arrangement within the atlas (here called bands, see image below). Please 

use the info tool (see section 2) to get information about the order of the different layer: 

 

4.7 How was the map/dataset created? What are the sources? 

To get information about the methods used for the creation of our datasets, please have a 

look at the Info tab (see section 3.1). Here, the scientific background is demonstrated includ-

ing the used sources, methods and further reading. These cover all the datasets in the cur-

rent map. If you want to get more information about a specific dataset, please switch to the 

Legend tab (see section 3.2Error! Reference source not found.) and select the Info symbol 

 behind the corresponding entry to get more information.  

4.8 I want to refer on the results displayed in the atlas. How shall I cite?  

If you want to refer on one of the datasets in your own publication we kindly ask you to use 

the correct citation. To get information on how to cite, please switch to the Legend tab (see 

section 3.2) and select the Info symbol  behind the corresponding dataset. There you will 

find two entries, Citation and Source.  

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941
http://www.qgis.org/


Braun A & Claus C (2014) The GLOWA Jordan River Atlas Manual. In: Claus C, Braun A, Schloz D, Tielbörger K 
(ed.) (2014) GLOWA JR Atlas: Results of the GLOWA Jordan River Project. http://nbn-
resolving.de/urn:nbn:de:bsz:21-dspace-579413, http://hdl.handle.net/10900/57941. 
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4.9 I have questions on the data. How can I contact responsible persons? 

If you have questions on datasets, please switch to the Legend tab (see section 3.2) and se-

lect the Info symbol  behind the corresponding dataset. There you will find the entry 

Contact, providing information on responsible persons and how to contact them.   

 

http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://nbn-resolving.de/urn:nbn:de:bsz:21-dspace-579413
http://hdl.handle.net/10900/57941

